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Introduction

ScriptE is the comprehensive software application for the Script 
Supervisor of the 21st Century. ScriptE takes you from the 
beginning when you import the script and begin the breakdown 
process all the way through the production when you print a 
complete and clean lined script.

Functionality Overview

Here is an overview of the steps you will take as you prepare 
the script, shoot it, and provide information to the production 
team.

•Start a new production in ScriptE

•Enter the participants

•Enter the character list

•Prepare the script in Final Draft

•Import the script into ScriptE

•Work through the breakdown process

•Provide breakdown reports

•Start a shoot day

•Log shots and wild tracks

•Time each shot with timecode

•Line the script

•Log action notes

•Log dialog changes

•Capture coverage stills from live video feed

•Log notes for each take

•Review the day’s activity

•Email day’s reports to participants

•Go home and get some rest
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Check for Updates

Before you get started, you will always want to ensure that you 
are running the latest version of ScriptE. The latest update may 
have bug fixes or other new functionality that may affect your 
work. So, you should periodically check for updates. To check 
for updates, be sure you are connected to the Internet then 
click the Help menu then the Check for Updates menu on the main 
ScriptE window. 

If updates are available, you will be instructed to close 
ScriptE and go to our website: www.ScriptESystems.com to 
download the latest version. At the website, click the Download 
button to navigate to the Download page and follow the 
instructions.

You can also check the version of ScriptE that you have by 
clicking the Help menu then the About ScriptE menu. Then, you 
can go to the website and click the Download button to see the 
version number of the latest version of ScriptE.
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Starting a New Production

First, and most important, is that you establish good workflow 
habits. During the course of a production you will have many 
files that you will need to keep organized: ScriptE production 
files and backups, scripts, reports, etc. 

So, the first step in starting a new production is to create a 
new folder for the production. If you are working on a 
television show, you will want to create a folder for each 
episode.

We recommend that you create your production folder on your 
desktop and leave it there until you get paid in full. The 
easiest way to do this is to find an open space on your desktop 
then right-click with your mouse. A pop up menu will be 
displayed where you can click the New menu then the Folder menu. 

A new folder will be placed onto your desktop with the words, 
“New Folder” highlighted. Type the name of your production and 
press Return.

We also recommend that you create four subfolders within this 
production folder:

SCRIPTE FILES - Contains all ScriptE production files.

REPORTS - Contains daily reports that you saved. We also 
recommend sub folders for each shoot day within the REPORTS 
folder.

SALVAGE - Put all unwanted files here rather than deleting them. 
They will be easier to recover, just in case.

SCRIPTS - Contains all versions of scripts from production.

The easiest way to create your subfolders is to double-click on 
the new production folder that you created on your desktop. This 
will open the folder in Window’s Explorer. Then, right-click in 
the right pane of the window. Next, click the New menu then the  
Folder menu in the pop up menu and a new folder will be created. 
Rename the new folder to SCRIPTE FILES then repeat this process 
to create the other three folders. You can now close Window’s 
Explorer.

You are now ready to create a new production file in ScriptE. 
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To start a new production file, in the main ScriptE window, 
click the File menu then the New menu. A file dialog will be 
displayed where you can select the location for your file and 
name the file. If you followed the recommended workflow and 
created your production file on the desktop, click on Desktop 
then double-click your production folder in the right pane. 
Next, double-click your SCRIPTE FILES folder.

The name of the new production file defaults to NewProduction 
with an extension of “.scripte.” You should change 
“NewProduction” to the title of your production. After typing 
the new name, click the Save button to save the file. You will 
see a series of messages as ScriptE prepares the file. 

Once the production window opens, you will notice the default 
title is highlighted, “NEW PRODUCTION.” 
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You should change this to the title of the movie, tv episode or 
commercial. ScriptE will later use this name to create a folder 
in the main ScriptE Data folder where any photos you capture 
during the production will be stored along with the daily 
reports that you email to production participants.

After typing the title, save the production by clicking the File 
menu then the Save menu or you can press Ctrl-S. 
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Add the Participants

One of the first things you should do in any production is to 
add the participants: Producers, Director, Editor, Script 
Supervisor, etc.

ScriptE will automate the process of sending daily reports via 
email to various participants but needs to know who they are and 
which reports and files each should receive.

ScriptE will also put the Script Supervisor’s name and 
information in the footer of many of the reports so be sure to 
enter yourself as well.

To add the Participants, click the Production menu then the 
Participants menu. The participants list will be displayed.

Click the Add button and enter the participant’s name, select 
their role in the production from the drop down list, then enter 
the rest of their contact information, if necessary. Be sure to 
enter their email address if they are to receive emails from 
ScriptE.

Each participant can receive one or more of the possible reports 
and files that are included in the email process. Scroll to the 
right in the list to see the options.

1st Shot

An email is sent to notify the participant that the first shot 
of the day has started. 

Partial Progress

This is a lunch report or mid-day progress report that includes 
work completed to that point in the day. 
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1st Shot After Lunch

An email is sent to notify the participant that the first shot 
after lunch has started. 

Camera Wrap

An email is sent to notify the participant that the shoot day 
has ended and at what time the camera wrapped.

Progress Report

This is a summary of the work for the day and work to date for 
the production.

Coverage

This is a kind of proof sheet of representative photos for each  
circle take for the day.

Editor Log

This is the log of shots and wild tracks in shot order.

Editor Log Red

This is nearly the same as the Editor Log but includes the Clip 
# field for shots logged using the Red camera.

Timecode Log

This is a log of shots and wild tracks in shot order that 
includes the timecode in and timecode out for each take.

Facing / Lined Script

This is a report that combines the facing pages for all activity 
for the day with the lined script pages that were affected. The 
lined script pages includes all coverage for each scene, not 
just what was shot on the selected shoot day.

ScriptE File

The actual ScriptE file for the production can also be included 
in the email as a backup or for those participants who might be 
using ScriptE to view the data directly.

ScriptE™ for Windows Tutorial

Copyright © 2007 ScriptE Systems, LLC.
Page 13 of 84



Clip Bin File

This is a tab delimited file that includes the scenes, slates, 
takes, short (editor) description, comments, timecode in and 
timecode out for all shots and wild tracks for the day. This 
file can be imported by the transfer house or editor.

Participants Summary

Each of the reports listed above and the Clip Bin File can be 
generated individually any time throughout the day and the Daily 
Report Email that includes all of the checked items for a 
participant can also be generated at any time during a shoot 
day.

When the reports are generated for the email, each version is 
saved in a folder called “Daily Reports” in your ScriptE Data 
folder under a folder with the same name as the title of the 
production.

If reports are generated for a shoot day that is not the latest 
shoot day, the word “Revised” will be included in the header of 
the report.

The participant list can be changed any time during the 
production.
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Exporting and Importing Participants

If you are working on productions for the same director, 
producers, etc. such as episodic television, you can move the 
participant list from one production file to another using the 
export/import functionality. This will save you having to type 
them all in for each episode.

Export the Participant List

To export the list, click the Production menu then the Export 
Participant List menu. You will be asked to select a location 
for the participant list file. We recommend that you store the 
file in the REPORTS folder of this production’s folder on your 
desktop. 

After navigating to the REPORTS folder, click the Save button.

Importing a Participant List

Open the production file into which you want to import the 
participants and click the Production menu then click the Import 
ScriptE Participant List menu. If you already have participants 
in this production file, ScriptE will ask if you want to add new 
participants to the file. If so, click the Yes button.

Navigate to the REPORTS folder of the previous production’s 
folder and select the file that was created in the previous 
step. Select the file then click the Open button. ScriptE will 
import the participants.
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Characters

The next step in the production process is entering the 
character list. Often times this list is provided to the Script 
Supervisor and character numbers have been assigned by 
production. 

The official character list should be entered before importing 
the script. If the official list is not available, ScriptE will 
automatically generate character numbers as it finds characters 
in the script during the import process. The character numbers 
can, however, be changed at any time during the production.

To access the character list, click the Script menu then the 
Characters menu.

To add a character, click the Add button and type their number 
and name. Optionally, enter an abbreviation that you will use 
when making notes and the actor’s name, if necessary.

ScriptE will automatically fill in the character number with the 
next number in the sequence so you will save time if you enter 
them in order.

If you need to change a character number, simply change it. But, 
if you are trying to use the same number that is already 
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assigned to another character, you will have to change the other 
character’s number first.

If you need to insert a character into the list and increment 
every other character with a higher number, select the character 
with the number you want to use then click the Insert button. 
The new character will be assigned the other character’s number 
and all other characters with a higher number will have their 
number incremented by one. 

For example, character number 2 is RON and there are several 
other characters numbered 3 through 10. If you want to assign 
the number 2 to BOB and shift everyone else down in the list, 
click on RON then click the Insert button and type BOB. RON will 
now be number 3 and 3 through 10 will become 4 through 11.

Exporting and Importing Characters

If you are working on productions such as episodic television 
with the same characters, you can move the character list from 
one production file to another using the export/import 
functionality.

Export the Character List

To export the list, click the Script menu then the Export 
Character List menu. You will be asked to select a location for 
the character list file. We recommend that you store the file in 
the REPORTS folder of this production’s folder on your desktop. 

After navigating to the REPORTS folder, click the Save button.

Importing a Character List

*If you have already entered characters for this production, you 
cannot import another character list so the menu will be 
disabled.

Open the production file into which you want to import the 
characters and click the Script menu then click the Import 
ScriptE Character List menu.

Navigate to the REPORTS folder of the previous production’s 
folder and select the file that was created in the previous 
step. Select the file then click the Open button. ScriptE will 
import the characters.
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Script Revisions

The next step is to enter the original script version. Open the 
Script Revisions list by clicking the Script menu then the 
Script Revisions menu.

The sample shows the first version has been entered and has also 
been imported.

Each time a revision to the 
script is issued, it should 
be added here.

Import a Script

ScriptE will import a 
script from Final Draft 
that has been saved in the 
proper format and break 
down all of the scenes for 
you, estimating the eighths 
of a page for each scene as 
well as the estimated 
running time. 

After the first version, ScriptE will compare the new version 
with the old and move any changed scenes to a “Previous Version” 
status and replace them with the new version unless the current 
version has already been shot. If the current version has 
already been shot, you will be notified that the scene has 
changed so you can note it during shooting.

Prepare the Script

Before a script can be imported, it must be properly prepared in 
Final Draft. With the release of Final Draft 8, this process 
became much simpler. We highly recommend that you purchase Final 
Draft 8 in order to help streamline this process. Even if 
production sends you the script from a previous version of Final 
Draft, you can still open the file in Final Draft 8 and save it 
in the new format. 

Prepare the Script in Final Draft 8

The only thing you will have to do to prepare the script is to 
make sure that the pages have been locked. Locking the pages 
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tells Final Draft to include page number information in the 
file.

To lock the pages, open the script in Final Draft 8, click the 
Production menu then the Lock Pages menu. The Lock Pages menu 
may show as “Lock A Pages”. Click the Lock Pages menu then 
repeat the process by clicking the Lock A Pages menu. Then save 
the script file and close Final Draft.

Prepare the Script in Final Draft 7

In order for ScriptE to be able to identify each page during the 
import, you must modify the header in the script. Currently, 
ScriptE is able to read a screenplay that is formatted with the 
standard Screenplay format in Final Draft.

In Final Draft, open the script’s header. Left of any other text 
that is already in the header, type PAGE# then click the Page 
button so the field “[Page #]” immediately follows PAGE# with no 
spaces. Then type ENDPAGE so it immediately follows the page 
field with no spaces. If there is too much text in the header 
for everything to fit on one line, you can remove any of the 
text that is there. 

ScriptE is only looking for PAGE#[Page #]ENDPAGE. Close the 
header.

Next, make sure the view of the script is set to 100%. Click the 
View menu, then the Zoom menu, then 100%. 

Click the File Save As menu under the File menu. When the save 
panel opens, select “Avid Script-Based Editing” from the 
“Format” pick list, select the folder where the file should be 
saved and click the Save button.

Import the Script

You are ready to import the script. Select the version in the 
Script Revisions list then click the Import button. 

Select the file you just saved. Final Draft 8 version scripts 
will have an extension of “.fdx” while Final Draft 7 scripts in 
the Avid format will have an extension of “.txt”. And, if you 
are using the recommended workflow processes, the script file 
should be located in the SCRIPTS folder of the production folder 
on your desktop. 
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After selecting the script file, click the Open button.

If shooting has begun, ScriptE will 
prompt you to select the shoot day to 
which this revision applies. When 
scenes are added or cut in a 
revision, the shoot day on which they 
are added or cut is recorded. The 
added and cut scenes will then be 
counted as such on the Daily Progress 
Report for the selected day. Select 
the day in the drop-down pick list 
and click the Import button. To cancel 
the import, click the Cancel button.

ScriptE will import and break down the script into scenes then 
let you know when the import has completed by displaying the 
scene list.

Scenes for Commercials

Often times the script for a commercial was not written in Final 
Draft nor does it conform to standard screenplay formatting. So, 
there will be no way to import the script. 

ScriptE provides a way for you to generate as many generic 
scenes as needed which you can then modify manually by entering 
a location and script text.

To generate a number of scenes, click 
the Script menu then the Scenes for 
Commercial menu. From the pop up 
window you can select the number of 
scenes you need and a starting scene 
number. Then click the Create 
button.You can create additional 
scenes later if needed.
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Scene Locations

As the script is imported, ScriptE creates a list of all the 
locations that were found in the scene headings. View the list 
by clicking the Script menu then the Scene Locations menu.

If a location is changed in this list, all scenes at that 
location will be changed automatically. This can be used if, 
during production, a particular location is unavailable and 
those scenes will be shot at a different location. For example, 
if the scenes at the amusement park are going to have to be shot 
at a carnival, change amusement park to carnival and all of the 
scenes at that location, will be changed.
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Scenes

View the complete list of scenes by clicking the Script menu 
then the Scenes menu.

Current Versions

This list always shows the current version of each scene. As new 
revisions are imported, the scenes that were changed will be 
moved into the Previous Versions list and replaced with the 
current version.

The “Included” checkbox indicates that the scene has not been 
omitted either in a script revision or manually on set.

If the script had indicated act breaks such as for a television 
show, the act to which a scene belongs would show in the “Act” 
column.

The script in the example shown was imported and ScriptE 
determined the eighths and estimated running time for each 
scene. The summary is shown at the bottom of the window. As 
scenes are shot and credited, the summary is automatically 
updated.

When a scene is partially credited, it will be displayed orange 
in the list and, once it is fully credited, it will be displayed 
green.
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Click the Script button to view the actual script in a separate 
window.

Previous Versions

When a revision is imported or scenes are revised, the previous 
version of every scene is stored. View the previous versions 
under the “Previous Versions” tab.

A previous version of a scene can be restored to the current 
list by clicking the button in the “Make Current” column. This 
will reset the current version as no longer current and will 
reset the previous version to be the current version.

Wish List

If during the course of shooting, there are shots you would like 
to get, time and budget permitting, they can be entered as wish 
list scenes. Enter them as you would a regular scene according 
to the instructions below but leave the scene number blank.

If you are ready to shoot a wish list scene, open it and assign 
it a scene number. When you save it, it will be moved into the 
Current Scenes list and then can be included in new shots.

Add a Scene

If the script is not available in Final Draft and cannot be 
imported or a new scene is added on the set, scenes can be added 
manually by clicking the Add button.

The Scene window will be displayed. Fill in the information 
according to the instructions in the next section of this 
tutorial.

Revise a Scene

If the script is not available in Final Draft and cannot be 
imported, you can create a new version of a scene by selecting 
the scene in the list then clicking the Revise button. You must 
enter the revision in the Script Revisions list first. ScriptE 
will verify that you want to copy the scene for the latest 
revision then copy it and move the current version to the 
“Previous Versions” list.

You can then make any modifications to the scene or the script 
for that scene manually. See the instructions in the next 
section of this tutorial.

ScriptE™ for Windows Tutorial

Copyright © 2007 ScriptE Systems, LLC.
Page 23 of 84



Edit a Scene

Double-click a scene in the list to edit it or select the scene 
in the list and click the Edit button.

Scene Window

When adding or editing a scene, the Scene window will be 
displayed.

Navigate from Scene to Scene

Use the Prev and Next buttons to move from scene to scene. If 
you make changes to a scene, you will have to save or cancel the 
changes before you can move to another scene.

Show Script

Click the Show Script button to display the script for the scene 
in the context of the full script. The script will be displayed 
in a separate window.

Included

This checkbox indicates whether the scene has been omitted or 
not. The box will be unchecked if the scene was found to be 
omitted during a script import.
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If you uncheck the box manually, ScriptE considers the scene a 
cut scene and will enter the current shoot day into the Shoot 
Day Cut field. These scenes are listed separately in the Daily 
Progress Report.

Owe Inserts

Check this box to indicate that, even though the scene may have 
been credited, you still want to get additional shots. These 
scenes will be included in the Scenes Owed report.

Script Chronology

When you enter the Script Day such as D1 or N1, ScriptE will 
look to other scenes to see if that same Script Day has already 
been used. If so, the Script Date and Weekday will be filled in 
automatically.

When you enter a Script Date, ScriptE will automatically figure 
out what day of the week that date is and select it from the 
drop-down pick list for you.

Shoot Day Started

ScriptE will insert the shoot day when the first shot is started 
for the scene.

Eighths Scripted / Estimated Running Time

ScriptE will estimate these during the initial import of the 
script. You can change them to more accurately reflect the 
length of the scene. The summary at the bottom of the Current 
Scenes list will be updated automatically.

Crediting the Scene

A scene can be credited here or in the Shoot Day window. ScriptE 
allows for a scene to be partially credited over several shoot 
days. To credit the scene here, click the 1/8s Credited button.

The list of eighths credited will be displayed.
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The top line in the window displays the scripted eighths and 
running time. The list will show how many eighths and seconds 
were credited for each shoot day. If you partially credit the 
scene on multiple shoot days, the list will display each entry.

The next line displays the total eighths and seconds credited to 
date and the following line shows the Remaining eighths and time 
that has not yet been credited. If the scene is marked as fully 
credited, the word “Remaining” will be replaced with 
“Difference” to indicate whether the full eighths and/or seconds 
have actually been credited.

To credit eighths and seconds, select the day to credit them 
from the drop down list titled “Day.” Then enter the eighths to 
credit and the seconds to credit. You can also type in the 
minutes then the seconds to credit on the far right. After 
entering the eighths and time to credit, click the Add button. 
The information will be added to the list and the totals and 
remaining will be recalculated. 

If you have now credited all the scripted eighths, you will be 
asked if you want to consider the scene fully credited. If so, 
the shoot day will be displayed in the drop down list at the 
bottom of the window. If the correct day is not shown, you can 
change it. 

If you make a mistake when crediting eighths, you can delete a 
line from the list. Select it in the list and click the Delete 
button. The totals will be recalculated and the shoot day fully 
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credited will be cleared since the scene is no longer fully 
credited.

When you are finished crediting the scene, click the Done button 
and the Scene window will be updated to display the 1/8s 
Credited and the Actual Running Time. If the same or more 
eighths are credited than are scripted, the eighths credited box 
will turn green. If more than zero but less than the total 
scripted eighths have been credited the box will turn orange. If 
the scene has not been credited at all, the box will be red.

You can also credit the scene from the Shoot Day window which 
will be explained briefly in that section of the tutorial.

Slug, Extras, Set, Effects, Transition, Tracking Notes

Enter freeform notes in each category. These notes will be 
included in the Long Form Breakdown Report.

Characters

This is the list of characters in the scene. 

ScriptE will add the characters that have dialog in the script 
for this scene when the script is imported.

Edit a character in the list to change their “In Scene Type” 
from “On Screen” to “Off Screen” or vice versa. 

You can add or delete characters from the scene as needed. When 
you add a character to the scene, they will also be added to the 
notes for Wardrobe, Hair, Makeup and Props so you can enter 
notes in those sections specific to a character.
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When you delete a character from the scene, they will also be 
removed from the Wardrobe, Hair, Makeup and Props notes 
sections.

The character numbers for all of the characters in the scene are 
included in the “Characters” column in the Short and Long Form 
Breakdown Reports.

Script

When ScriptE imports a script, it breaks the scene down into 
parts: heading, action, and dialog. Each paragraph of action and 
each block of dialog are stored as individual parts for various 
technical reasons.

In Final Draft, the writer can indicate that a block of action 
is a scene heading and assign it a scene number even though it 
doesn’t have a standard scene heading with an “INT” or “EXT” 
indicator. The “This scene has a scene heading in the script” 
checkbox will not be checked for scenes of this type and the 
Int/Ext drop down pick list, the location drop down pick list 
and the time of day extension box will be disabled. And there 
will not be a “Heading” script part for this scene.

Prior to shooting a scene, the script can be modified here. If a 
Final Draft version of a revision is not available for import 
and the scene has been “Revised” manually, the changes to the 
script can be made here. Or, if a new, unscripted scene needs to 
be added, the actual script can be entered here.

Click the Add button to add a new script part. If this is a 
brand new scene that you added manually, the Heading will be 
created for you. But you can add action and dialog to fill out 
the script. 
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When you click the Add button, a window will be displayed where 
you can create the script part.

Identify the type (action, dialog, etc.). If you are adding 
dialog, select the character and add any modifier such as 
(O.S.). Finally, type the action description or dialog in the 
“Text” box. The heading is not included here because it will be 
modified automatically if you select a different INT/EXT, 
location or change the time of day in the main scene window.

When you are finished, click the Save button.

To modify a script part, select it in the list then click the 
Edit button. The same window will be displayed where you can 
make the changes.

To rearrange the order of the parts in the script, select a 
script part in the list and click the Up or Down button.
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Wardrobe, Hair, Makeup, Props

These notes sections include special functionality to make the 
breakdown process easier. Each character in the scene that is 
identified as being “On Screen” will have a line in the notes. 
If a new character is added to the scene, they will be added to 
the notes. If a character is removed from the scene, they will 
be removed from the notes.

The “Items” column is where you can place list of items that 
pertain to the character. Be sure to separate the items with 
commas. Each item will be added to a smart list that you can 
select from for the same character in other scenes.

To use the smart list, double-click in the “Items” cell next to 
the character. Or, click into the cell for editing so you can 
type new items. Then, press Ctrl-L to pop up the smart list. 
ScriptE will display a list of all items you have entered for 
that character of that particular type that have not already 
been included in this scene. In other words, if you are in the 
wardrobe notes, you will see a list of other wardrobe notes you 
have entered for that character. 
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Use the arrow keys to move up and down the list then press Enter 
to add an item to the notes. Or, double-click on each item in 
the list you want to add for that character. As each item is 
selected, it will be removed from the list so you won’t select 
it twice. After selecting all the items required for the scene, 
press Esc to close the Smart List window.

In addition to entering smart list notes for characters in these 
sections, you can also enter smart list notes in the Props notes 
that aren’t specific for a character. Place the cursor in a 
blank line below the character names and enter props for the 
scene there. They will be added to a special props smart list. 
Also, prop notes are shared among characters since one character 
may have the gun in one scene but another character may have it 
in another scene.

You can also enter other free form notes for a character in the 
General Notes column.
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Shots

This is a list of all shots that involved this scene.

Double-click on a slate in the list to open the shot in a Shot 
window.

Click the Photos button for a take to view the photos that you 
captured for this take. Capturing or grabbing (importing) photos 
will be discussed in another section of this tutorial.

Click the Circle Take Photos button to view the representative 
photos for all of the circle takes for this scene. When you 
capture photos in ScriptE or grab photos from an external 
source, you can identify one or more photos for each take to be 
the representative photos for the take. 

Click the Facing and Lined Script button to create a Facing and 
Lined Script report that includes all shots for this scene.

WT

This is a list of all wild tracks that have been recorded for 
this scene. Double-click a wild track in the list to open it in 
a Wild Track window.
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Editor Notes

Editor notes are included in the Editor’s Log and Facing Page 
Reports.

?

Questions entered here are included in a separate section at the 
end of the Long Form Breakdown Report.

Breakdown Process

As a part of the breakdown process, ScriptE suggests starting at 
the first scene and entering the wardrobe notes. Then, save the 
scene and click Next or Alt-N to go to the next scene. The 
wardrobe notes will still be displayed. 

Use the smart list to fill in wardrobe notes and add other 
wardrobe notes for the scene and repeat until you have reached 
the final scene. Repeat this process for hair, makeup and props.

Long and Short Form Breakdown Report

After completing the breakdown, you can print the Long and/or 
Short From Breakdown Reports. Each report can be sorted in 
various ways: Scene #, Location, Script Day, Script Date, Int/
Ext Location.

If the scenes are designated by acts and you sort the report by 
the Scene #, each act will be separated in the report with a 
subtotal for each act as to the number of scenes in the act, the 
number of scripted pages, and the estimated running time.

Under each of the menus for the Long Form Breakdown and the 
Short Form Breakdown is an option to Show Estimated Running 
Time. You can uncheck this option to display 0 for the estimated 
running time in the report, in case you are not being paid for a 
timing.
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Start Shooting

All shots are recorded on a specific 
shoot day. Click the Production menu 
then the Shooting Days Summary menu  
to view the list of shoot days so 
far.

Click the Add button to add a new 
shoot day or double-click a shoot 
day in the list to view the activity 
for that day.

New Shoot Day

When you add a new shoot day, the Shoot Day window will be 
displayed with the Time tab preselected.

Enter the Crew Call time or times then click the Start Shooting 
button.

The First Shot, First Shot after Lunch, and the First Shot after 
Dinner will be filled in automatically.

When you break for lunch, return to this window to enter the 
time when lunch was called, the Duration, and the time back in 
from lunch. 

When you break for dinner, do the same for the dinner times. 
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Then, at the end of the day, return to this window to enter the 
Wrap times and to review the days activity before sending out 
the daily reports.

Slates

This is a list of all camera slates and takes for the day in the 
order they were shot.

Camera/Sound Roll

A new camera roll or sound roll will be orange. If the camera 
roll or sound roll has not been entered, the cell will be red.

Photos

View the photos that you captured during a take by clicking the 
button in the “Photos” column for the desired take.
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Editing Information

Most of the information for a take can be modified here but you 
can view the slate in a Shot window by double-clicking in the 
row for the slate/take you want to view. You must double-click 
in one of the first three columns. 

To edit one of the columns with a drop-down pick list, select 
the new value from the list. To edit one of the other columns, 
double-click the cell and type the new value.

Scroll to the right to see additional fields.

Camera Information

The last five fields starting with “Lens” are usually entered 
once for the camera or cameras used in the shot. If you change a 
value for take 1, the value will be copied to the rest of the 
takes for the same slate and camera. If a change was made for 
one of the settings for a specific take, enter the value in the 
appropriate line for the take. The value will not be copied to 
the other takes since it is unique for that particular take. 

In other words, save yourself some time and always enter the 
information for the first take of a slate and you won’t have to 
enter it for every take. Then, enter any values that are 
different for a specific take.
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Scenes Shot Today

This is a list of all scenes that were included in shots on this 
shoot day.

When a scene has been fully credited, it will be displayed 
green. If it is partially credited, it will be yellow. 

To view the scene in a Scene window, double-click the row for 
the scene.

Credit Scenes

In the end of day review, you can credit scenes. Click the All/
Partial button in the “Credit” column and fill in the eighths 
credited today and the actual running time for the day. See the 
instructions in the Scene section for crediting scenes. 

Owe Inserts

You can also indicate that the scene still needs some insert 
shots by clicking the checkbox in the “Owe” column.
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Setups

This is a list of the setups for the day and which slate is 
associated with which setup.

Every time a camera is added to a shot, a new setup is added. If 
a camera for a shot belongs to a different setup, the correct 
setup can be selected in the Shot window in the cameras list. 

If a slate has more than one camera, the slate number may appear 
with more than one setup. 
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Wild Tracks

This is a list of all wild tracks recorded for this shoot day.

A new sound roll is displayed orange. If the sound roll has not 
been entered, the cell will be displayed red.

Add a Wild Track

To add a new wild track, click the Add button. The instructions 
for entering a wild track are in a later part of this tutorial.

Edit a Wild Track

All but the first two columns can be modified here. Select a new 
value from the drop-down pick list or double-click in the cell 
and type a new value.

To open the wild track in a Wild Track window, double-click in 
one of the first two columns in the row for the appropriate wild 
track.

Weather Notes

This is a place where you can enter notes concerning the weather 
for the shoot day that will be included in the Daily Progress 
Report.
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On Set Notes

This is a place you can record notes that will not be included 
in any of the reports. What happens on set, stays on set.

Production Notes

This is where you enter general notes about the shoot day that 
will be included in the Daily Progress Report.

ScriptE™ for Windows Tutorial

Copyright © 2007 ScriptE Systems, LLC.
Page 40 of 84



Entering Shots

When you start a new shoot day, you will enter the crew call 
time then click the Start Shooting button. ScriptE will open a 
blank Shot window for you.

Enter the Slate

Type the slate and press tab. If you accidentally enter a slate 
that you have already used, ScriptE will let you know.

If you press tab again, the cursor will move to the Add Scene # 
box where you can add scenes to the shot.

Identify the Type of Slate

ScriptE will default the shot to a regular shot but you can 
change it to a retake if necessary. Retakes are identified 
separately in the Daily Progress Report.
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Enter the Scene

Type the scene number that will be included in the shot in the 
“Add Scene #” box then press Enter. Enter as many scenes as will 
be included in the shot. 

If you need to rearrange the order of the scenes, select a scene 
in the list and click the Up or Down button to move it in the 
list.

The order that the scenes appear in the list determines the 
order that the script will be displayed during the shot.

Click the Action Tab

After entering the scene or scenes, click the Action tab. The 
Camera Selection window will be displayed.
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Camera

If this is the first camera you are adding to the shot, camera 
“A” will be selected for you. If you are adding an additional 
camera to the shot, the next camera letter will be selected for 
you. 

Setup

Every time a camera is added to a shot, a new setup for the 
shoot day is added and the camera linked to it. If the camera 
should be linked to a previous setup, select it in the drop-down 
pick list.

Shot Look

The shot look determines where the camera line will be drawn on 
the lined script. The wider the shot, the further left it will 
be drawn. The closer the shot, the further right it will be 
drawn. 

If you don’t select the shot look, the camera line will be 
displayed near the left side of the script.

Other Information

You can fill in as much of the information as you know at this 
time. Or, you can fill it in later which you will learn shortly.

Add the Camera to the Shot

After selecting the correct camera body (letter) and entering as 
much information as you have, click the Add This Camera button.

The script for the selected scenes will be displayed on the 
right side of the window along with a blank camera line for this 
camera.

To add additional cameras to the shot, click the Add button 
above the cameras list.

It is also very helpful to enter the camera roll at this time 
because once ScriptE associates a camera roll to a camera body, 
it will automatically fill in the camera roll for subsequent 
shots. Enter the camera roll in the cameras list in the CR 
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column. The sound roll should also be entered for the same 
reason.

Live Video Feed

If you have a live video feed from which to capture stills, be 
sure you have enabled it in ScriptE. Click the Production menu 
then the Grab Live Video Feed menu. 

Photo Capture

The Capture Photo button is only enabled when the stopwatch is 
running during a take so that any photos captured can be 
properly linked to the appropriate take. Use Alt-P to capture a 
photo or click on the Capture Photo button.

No Live Video Feed

If you do not have a live video feed and you are using an 
external source such as a digital camera to capture coverage 
photos, be sure to synchronize the date and time on your camera 
with the date and time on the computer. 

If the date and times are exactly the same or very close to the 
same, when you import or grab the photos, ScriptE will be able 
to identify which photo or photos belong with each take and save 
you the trouble of having to identify them.

You will find specific instructions on importing or grabbing 
photos from an external source later in this tutorial.
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Scrolling the Script View

The main way to scroll the script section is to use the scroll 
bars with your mouse. But, we have provided a couple of other 
ways to make scrolling easier. Another way is to use the arrow 
keys.

Additionally, we have provided another method that helps to keep 
your left hand on the home row of the keyboard. Normally, the 
cursor will be in some part of the script because you will be 
making notes that occur at specific places in the script. And, 
after adding notes, the cursor will return to the original 
location in the script where you made the note. So, you can 
press R to scroll the window up and V to scroll the window down, 
to see the lower part of the script.

If the cursor is in the notes section at the bottom of the 
window where you can type freeform notes during a take, you can 
use the arrow keys combined with the Ctrl key to scroll the 
script window. The Ctrl key is necessary so that you can move 
the cursor within the box using the arrow keys.
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Line the Script

It is best to draw the camera line now so when you move to 
subsequent slates, the previous coverage will be drawn on the 
script for you. But, you can always return to the shot and draw 
the line later.

To begin drawing, click in the camera line at a point in the 
line where you want the line to start. The Camera Line options 
window will be displayed. The first time you click the camera 
tube only three of the drawing options are available. These 
three are used to establish the base line of the shot. The rest 
of the options will be available on subsequent clicks.
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Where Did I Click?

The box at the top of the window shows the part of the script 
across from which you clicked in the line. If that is not the 
part of the script where you intended to click, press Esc or 
click the Cancel Line Drawing button.

Indicate a Specific Point

If you want to indicate that this line part starts or occurs at 
a specific word or point in the body of the script, click at 
that spot in the script box at the top of the window. A red 
asterisk will be displayed.

If you clicked at a point in the script box but don’t want to 
use that point, click another spot or click the Clear Point 
button to erase it completely.

When you establish a starting point within the body of the 
script, a line will be drawn on the script from the camera line 
to that point in the script.

On Camera, Off Camera, Dirty

First Line Part Selected

The first line part you select will generally be On Camera, Off 
Camera or Dirty. Selecting one of these as the first line part 
will simply draw that type of line from the starting point to 
the end.

* If you clicked anywhere next to the scene heading as shown in 
the example, ScriptE will start the line at the beginning of the 
heading. You don’t have to try and click exactly at the 
beginning.

Subsequent Line Parts - Action

After the first line part has been drawn with one of the three 
types listed above and you select one of those three at a 
different point in the line next to action, ScriptE will draw 
the new line part starting at that point and extending to the 
end. 

If you have multiple scenes in the shot, ScriptE has to treat 
them somewhat individually and create the same line part 
starting at the beginning of each scene. This means that the new 
line part will only extend to the start of the next scene. To 
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continue the same line type into the next scene, you will need 
to click near the heading for that scene and select the same 
line type.

Subsequent Line Parts - Dialog

If you clicked in the line next to dialog and select one of 
these three line types and the dialog for that character is not 
the last block of dialog for that character in the shot, you 
will be given the option to copy the same line type for all 
subsequent blocks of dialog for that character.

If you click Yes, ScriptE will copy the line type for all 
subsequent blocks of dialog for the same character in the shot.

If you click No, ScriptE will just use the line type for the 
selected block of dialog. 

If you selected a specific point within the dialog where the 
line should start, however, you will not be given the option to 
use the same line type for the remaining dialog.

For dialog, unless you selected a specific starting point in the 
script, ScriptE will always start the line at the beginning of 
the character’s name and end it at the end of the block of 
dialog. You don’t need to worry about clicking exactly even with 
the character’s name. 

Also, if the dialog is the first thing in the scene, ScriptE 
will start the line at the beginning of the scene heading.

Clear All

Clicking this button will clear the entire line so you can start 
over. If you select this option while working in take 1, the 
line will be cleared. If you select this option while in a take 
after take 1, you will be asked whether you are clearing the 
line or clearing it so you can create a unique line for this 
take. You can create a unique line for a take but it is not 
recommended since more lines may be harder to read on the page.

Clear From Here Down

Clicking this button will clear the line from the point where 
you clicked in the line to the end.
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End Line

Clicking this button will draw a line across the line at the 
point in the line where you clicked and clear the rest of the 
line.

Eye Line Camera Left, Eye Line Camera Right

If you clicked the line near dialog, the eye line lines work the 
same as On Camera, Off Camera and Dirty. You will be asked if 
you want to use the same line type for the remaining dialog of 
the same character.

If you click Yes, ScriptE will add eye line indicators at each 
block of dialog for the same character.

If you select one of these line types for a take after take 1, 
the take number will be displayed with the indicator.

Don’t Use Starting Here, Don’t Use Ending Here

Use these line types to block out a section of the camera line 
that should not be used.

Take Starts Here, Take Ends Here

Use these line types in takes to indicate that a particular take 
started or ended at a different point than the beginning or end 
of the line.

Cross Axis

Select this line type to indicate that the camera crossed axis 
at this point.
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Rolling

There are three ways to roll as indicated by the three stopwatch 
buttons.

Take - This button increments the take number for the shot and 
can be started and stopped by pressing the key combination, 
Alt-3.

Pick Up - This button increments the take number for the shot 
but identifies the take as a pick up take. Use Alt-5.

Continuous - This button does not increment the take number but 
creates a unique clip for which you can make notes. Use Alt-1 
for this button.

When the camera starts rolling, click one of the three Stopwatch 
buttons to start the timer and set the timecode in for the take 
(if you have set timecode). **ScriptE logs the start/stop time 
and timecode the instant you click the button not after you have 
finished recording your notes.

The shot window will indicate when you are rolling as shown in 
the sample below.
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When the director calls “cut,” click the button again or use the 
appropriate key combination to end the take or clip.

Logging Notes

As the shot progresses you may want to record action notes to 
indicate how an actor performed an action such as holding a 
glass or dialog changes to note alternate dialog the actor used 
or omitted.

The first step is to click in the script at the spot where the 
action occurred or to select the dialog that was changed or 
omitted. 

A single click will be interpreted by ScriptE and the nearest 
word in the script will be used to indicate where the action 
happened or dialog was changed. Double-clicking will select a 
word. Triple-clicking will select a phrase or sentence. Or, drag 
and select the word or words that were changed in dialog.

After selecting the spot in the script, press the appropriate 
key as shown below to create the appropriate note. Notice the 
keys use the home row keys of the left hand.

A - Action Note - Use this to note stage direction.

Q - Omitted Action - Use this to note scripted action that has 
been omitted.

S - Inserted Dialog - Use this to insert another character’s 
dialog in the middle of scripted action or that interrupts 
another character’s scripted dialog.

D - Alternate Dialog - Use this to indicate modified dialog.

F - Omitted Dialog - Use this to indicate dialog that the actor 
did not use.

Action Notes - A

When you press the A key, a box will appear directly below the 
cursor so you can quickly type the action note. Be sure to 
always press Enter after typing to dismiss the pop up box. If 
you don’t want to type the note immediately, just press Enter to 
dismiss the box. 
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After you press Enter, an action note will be added to the left 
side of the script. You can always click in the lower of the two 
boxes to type or modify the note.

The example shown was logged in take 2. If the note had been 
logged during the first take of the first shot for the scene, it 
would have been displayed with the color you selected for first 
shot action notes. And, the slate and take would not be 
displayed.

The upper half of the note shows the slate and take during which 
the note was recorded along with the word to which the note is 
related. 

On the right side of the upper half of the note is a button with 
a “T”. While logging subsequent slates and takes for the same 
scene, click the button to indicate that the note applies to 
those slates/takes as well. Every slate and take to which the 
note applies will be listed.

On the far left of the note is a slender button. Click this 
button to open the action note in a larger window for 
modification or to delete the note.
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Change the Linked Word

To change the word in the script to which the note is linked, 
select a new word or words in the box at the top of the window.

Takes

The example shows that the note applies only to take 2 of slate 
20. You can check additional takes to which the note applies or 
uncheck a take if necessary.

Or, to apply the note to all takes, click the Apply All button.

Delete the Note

To completely delete the note, click the Delete button.

Save the Changes

After making the necessary changes, click the Save button to 
save the changes and close the window.

Omitted Action - Q

This note can only be added when you have placed the cursor or 
selected one or more words in an action paragraph. This note is 
to indicate that a particular action was not taken.

When you press the Q key, an omitted action note will be added 
to the left side of the script. Follow the instructions for a 
regular Action Note above for managing the omitted action note.

Inserted Dialog - S

When you press the S key, you have indicated that a new line or 
block of dialog should be inserted that wasn’t scripted. For 
example, JANE is supposed to say, “Stop the train. I have to get 
off.” But, the actor playing ROGER, after JANE says, “train”, 
says, “Impossible.” Then JANE finishes her line, “I have to get 
off.” ROGER’s line was inserted into JANE’s line.

A list of characters in the scene will be displayed so you can 
select the character who inserted the new line. Click once on 
the character in the list and the inserted dialog note will be 
displayed on the right side of the script.

Type the line of dialog in the box and press Enter.
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To indicate that this inserted dialog applies to subsequent 
takes, click the T button during a take.

To open the inserted dialog note in a larger window for editing, 
click the slender button in the center of the note.

Modify Script

If the director decides that this new line of dialog should be 
used for all subsequent shots, you can insert it into the script 
by clicking the Modify Script button. You will be reminded to 
make sure the dialog is correct before clicking the Save button.

When you click the Save button, the script will be modified as 
necessary. In the example, WOMAN’S VOICE dialog will be split 
into two parts and LEONARD’S dialog will be inserted between 
WOMAN’S VOICE lines.

Also, for all takes where this line was not used, an omitted 
dialog note will be added to indicate that those takes did not 
include this line.
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In addition, the camera lines for all shots where this new 
dialog was not used will be split to indicate that those shots 
did not cover this line of dialog.
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Alternate Dialog - D

If press the D key, you have indicated that the actor changed 
the dialog. An alternate dialog note will be added and displayed 
on the right side of the script with the other dialog change 
notes.

In the example, MAN’S VOICE said, “years” instead of “months.”

To open the alternate dialog note in a larger window, click the 
slender button in the center of the note.

Modify the Script

To modify the script to use the new dialog, click the Modify 
Script button. ScriptE will replace the old dialog with the new 
in the box at the top of the window. Make sure the dialog is 
correct and that all applicable takes where this dialog was used 
are checked then click the Save button.

ScriptE will modify the script and add a note for the original 
script.
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Omitted Dialog - F

If pressed the F key, you have indicated that the selected 
dialog was omitted during a take. An omitted dialog note will be 
added to the right side of the script. Nothing further to do on 
your part.

To view the omitted dialog note in a larger window, click the 
slender button in the center of the note.

Modify the Script

To modify the script and remove the omitted dialog, click the 
Modify Script button. The omitted dialog will be removed in the 
box at the top of the window. Be sure the new dialog is correct 
and that all applicable takes where the dialog was omitted have 
been selected then click the Save button.

ScriptE will modify the script and add a note for the original 
script.

If you remove the entire block of dialog, the character name 
will remain in the script as ScriptE needs that placeholder for 
technical reasons.
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Cut

When the director cuts, click the Stopwatch button that you 
clicked to start the take or use the appropriate key 
combination.

After each take you will be given the opportunity to rate the 
take and record your comments. The window shown below will be 
displayed.

Each clip for each camera individually can be identified as a 
circle take. If you have multiple cameras in the shot, you can 
mark them all as a circle take at the same type by clicking the 
Circle button at the top of the window.

Or, if you just want to indicate that the A camera was a circle, 
select circle in the Status drop down pick list next to camera 
A.

You can then select a FAV identifier for each camera’s clip and 
add comments if needed.

If you mark them as Ignore, action notes and dialog change notes 
will be hidden on the script page.
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New Slate

After completing all the takes for a slate and you are ready to 
prepare for the next shot of the same scene or scenes, click the 
New Slate button.

ScriptE will prepare the window and increment the slate number 
to the next slate. If the slate number is correct, tab out of 
the box.

Click the Add button next to “Cameras This Slate” to add a 
camera to the new shot. Once you add the camera, the script and 
camera line will be displayed along with the action and dialog 
notes from the previous shots. Remember that, if a take is 
marked as ignore, those notes won’t be included.

If you are setting up a shot for a different scene or scenes, 
change the slate number as needed then click the Scenes tab. 
Remove and add scenes from the list as needed then click the 
Action tab and proceed as usual.

Another option for starting a new slate is to close the Shot 
window and click the Add button on the Slates tab of the Shoot 
Day window. Which is how you got here in the first place.

Coverage

If you want to view the camera lines from previous shots, click 
the Coverage button just below the script. The button will be 
changed to “Live.” 

After viewing the coverage, click the Live button to return to 
the “Live” view. 

If you are viewing the coverage and click a stopwatch to roll a 
take, the window will automatically be returned to the live 
view.
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Shot Window

Split Window

For your convenience, the Shot window is split. Drag the divider 
to the right to reveal more of the fields in the lists on the 
left side of the window.

There is another splitter on the right part of the window 
between the script and the video/notes section. This splitter is 
just below the action/dialog note buttons. This will allow you 
to adjust the size of the video feed vertically.

There is another splitter between the video feed and the notes 
box to allow you to size the video feed horizontally.

If you double-click in the title bar of the shot window, it will 
be sized to an optimal size.
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Video Ratio

If your incoming video image is not in the standard 4:3 ratio, 
you can adjust the ratio in order to optimize the video image. 
Click the Production menu then the Set Video View Ratio menu.

This is best done with the video feed live and the shot window 
in the background. Enter the width and height values then click 
the Test button. The image will be adjusted. When you have the 
best ratio, click the Done button.

Cameras This Slate

This is a list of the cameras that are being used in this shot.

Double-click on a row in the “Slate” or “Camera” column to open 
the Camera Settings window and make changes to the camera 
settings. Or, edit the appropriate fields in the list itself by 
making selections from drop-down pick lists or double-clicking 
in a cell to change the value.

Scroll to the right to see all the information you can change 
including the camera roll, sound roll, and setup.
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Takes

This is a list of all of the takes for this slate. Double-click 
on a row in the “#” column to open the Camera Settings window. 
Or, edit the appropriate field in the list itself.

Changing Information

Remember when entering information for Lens, Filter, T (F or T 
Stop), LH (Lens Height), Distance, Frame Rate and Shutter Angle 
enter the information into take 1 first. ScriptE will copy it to 
all other takes for you. Then, if something was different for 
another take, enter the change for that specific take.

Photos

Click the Photo button for a take to view the photos you 
captured for the take. See the section in the Tutorial that 
explains what to do with the photos after you have captured 
them. If the button says “None” then you did not capture any 
photos for that take. If the buttons says “Select” then you did 
capture photos but have not selected any representative stills. 
If the button says “View” then you have selected one or more 
representative stills.

Change Current Take

You can change the current take that is the focus of the Shot 
window by clicking one of the pointer buttons at the right side 
of the takes list. 

For example, if take 1 is displayed and you click the right 
pointer button, take 2 will be displayed. If take 3 is 
displayed, click the left pointer button and take 2 will be 
displayed.
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Other Slates/Takes

This tab displays a list of all other slates and takes for all 
scenes included in this shot. Scroll to the right to see all the 
columns in the grid.

Double-click on a row in the “Slate” column to open the Camera 
Settings window to make changes. Most fields can be changed 
right here in the list. 

Click the button in the “Go” column to open the shot in its own 
window.

Click the button in the “Scene” column to open the Scene window. 
If multiple scenes are included in a shot, all the other slates 
and takes for all scenes in the shot will be included in this 
list.

Other Wild Tracks

This is a list of wild tracks that have been recorded for scenes 
in this shot.

Click the button in the “Go” column to open the wild track in 
its own window.

You can modify the data in any column except the Slate.
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New Wild Track

To add a new wild track, click the Add button under the Wild 
Tracks tab on the Shoot Day window.

ScriptE will open a blank Wild Track window for you.

Type the slate and press tab then enter the scene or scenes 
included in the wild track. After entering the scene or scenes, 
click the Action tab.

A default description for the wild track will be added for you. 
You can change it at any time. And, the script will be displayed 
along with all of the coverage from camera shots and other wild 
tracks.

Start and stop the appropriate stopwatch and add notes the same 
as for a camera shot. 
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When stopping the stopwatch, you will be prompted to enter your 
rating and comments for the take and to indicate whether it is a 
circle take or not.

“Camera” Line

A camera line is placed 
on the script for you 
in case you want to 
indicate what is being 
recorded in the wild 
track. For example, 
when voice over dialog 
is recorded.

The camera line type 
selector is a little 
different for a wild 
track since there are 
no cameras involved.

Several of the options 
are disabled since they 
don’t apply to a wild 
track.
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Photos

As you have seen, ScriptE can pick up a live video feed that you 
can use to capture stills during takes. As each photo is 
captured, it is given a filename that includes the slate, take, 
and the date and time that it was captured to the millisecond. 

Photos, whether captured or imported, are stored in the same 
folder as your ScriptE data that you selected when you first ran 
ScriptE. 

A folder is created for the production using the title of the 
production. Then a folder is created for each slate with folders 
for each take under the slate folder. The photos for each take 
are stored in the respective take folder.

To capture photos from the live video feed, click the Capture 
Photo button at the bottom of the Shot window or press Alt-P.

Grab Photos

If you do not have a live video feed from which to capture 
photos, ScriptE allows you to import photos from an external 
source such as a memory card from a digital camera. 

If you are using an external source, be sure to set the date and 
time on the camera or other device to match as closely as 
possible the date and time on your computer. ScriptE will 
determine which photos apply to which takes based on the date 
and time of the photo file.

To grab photos from a memory card or hard drive, click the 
Production menu then the Grab Photos menu. An open file panel 
will be displayed where you can select the photo files from your 
hard drive or memory card. Select one or more photos and click 
the Open button.

ScriptE will load the photos into the window shown below where 
you can select representative photos for each take.
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If the correct slate/take is not already selected, select it 
from the drop-down pick list for each photo.

Check the box in the “Rep” column to identify one or more photos 
for each take as representative photos for the take. The 
representative photos will be included in various reports.

If you do not want to keep a photo, click the box in the 
“Discard” column for the photo.

After reviewing the photos and selecting the representative 
photos, click the Save button. ScriptE will copy all of the 
photos not flagged to be discarded into the folder structure 
described above. The original file names will be retained.

If you want ScriptE to delete the original files after they are 
imported, be sure the box is checked next to “Delete photo files 
from source.”

Viewing Photos

Now that you have captured or imported all of these photos you 
will want to view them. Photos for a take can be viewed from the 
Shot window or Scene window or even the Shoot Day window. 
Wherever you see a Photo button.
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When you open the photos for a take, the window shown below will 
be displayed.

Remove a photo as a representative take by unchecking the “Rep” 
checkbox. The photo will be saved in the folder but will no 
longer be a representative still.

Click the Show All Photos button to view all photos for the take 
including those not selected as representative photos.

Click on a photo in this list to view it in the larger window.

To flag an additional photo as a representative photo, check the 
“Rep” checkbox for the photo.

If you want to discard a photo, check the “Discard” checkbox. 

After making the necessary changes, click the Save button to 
lock them in.
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Circle Take Photos

You can view all of the circle take representative photos for a 
scene by clicking the Circle Take Photos button on the Shots tab 
of the Scene window.
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Camera Rolls

A list of all of the camera rolls that have been used in the 
production can be viewed by clicking the Production menu then 
the Camera Rolls menu.

Select the film stock and add any processing notes for each 
camera roll.

Camera Roll Report

The camera roll report can be found under the Reports menu. It 
is a listing of each camera roll and the slates and takes that 
were included in each roll. Circle takes are circled.
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End of the Shoot Day

And so the shoot day has reached an end. Time to review the 
day’s activity and email the reports. Close any open Shot 
windows and return to the Shoot Day window for today. 

If the Shoot Day window is not open, open the Shooting Days 
Summary window and double-click on the current shoot day in the 
list.

Review Slates and Takes

Click the Slates tab and make sure the information for all the 
shots has been entered: camera and sound rolls, circle takes, 
comments, and camera information.

Review Scenes

Click the Scenes Shot Today tab and credit scenes as necessary. 
Decide whether any scenes are owed additional shots.

Review Setups

Click the Setups tab and make sure that the slates are linked to 
the correct setups. To make changes, open the shot from the 
Slates list and change the setup for the appropriate cameras in 
the cameras list.

Review Wild Tracks

Click the Wild Tracks tab and make sure the sound roll has been 
entered for every take. Verify that the circle takes have been 
identified and the comments have been entered.

Notes

Add any Weather, On Set, or Production notes for the day. 
Remember that weather and production notes will be included in 
the Daily Progress Report.

Enter Time

Click the Time tab and make sure all the times for the day have 
been entered accurately.
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Review Reports

Review the daily reports that will be emailed to participants by 
running each daily report individually.

Email Reports

If all of the information in the reports is correct, clicking  
the Reports menu then the Email All Daily Reports menu. ScriptE 
will compile all of the reports, save them in pdf format in your 
Daily Reports folder and email them to all applicable 
participants.

Save Daily Reports to Folder

In addition to emailing the daily reports, you can also save 
them to a folder or thumb drive by clicking the Reports menu 
then the Save Daily Reports to Folder menu. You will be prompted 
to select the folder then ScriptE will prompt you to select the 
reports that you want to include. The reports will then be 
processed and saved in pdf format in the selected folder or 
location. 

ScriptE Select Backup

At any time during the work day, if you are a ScriptE Select 
subscriber, you can email a backup of your file to ScriptE 
Systems. Then, if a problem occurs, we can better assist you by 
looking at the actual data. Also, if something were to happen to 
your computer, you can be assured that we will always have a 
backup of the file that we can send to you. 

Naturally, the file can only be sent when you have an Internet 
connection and are able to send and receive emails. 

When you send the backup by clicking the File menu then the 
Backup to ScriptE Systems menu, you will receive a prompt 
letting you know that your backup arrived at ScriptE Systems.
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Reports

ScriptE includes many reports and sorting options for those 
reports.

Script Revision Differential

When you import a new script revision, ScriptE doesn’t change 
the scripted eighths nor the estimated running time for the 
revised scenes. You will need to review the changed scenes and 
make any adjustments that are necessary unless a scene was 
omitted. You do not need to change the eighths or the running 
time to zero for an omitted scene.

If a new scene was added that didn’t exist in the previous 
version, ScriptE will estimate the eighths and running time for 
the new scene.

After making the adjustments to the eighths and running time for 
the revised scenes, run this report to see a scene by scene 
comparison for all revised, added, and omitted scenes and the 
overall effect on the script length and running time.

Select the revision for the report in the Script Revisions 
window then select the Script Revision Differential menu. 

Long Form Breakdown

This report includes a list of all the scenes in the script 
including all of the notes such as the wardrobe and hair notes.

If the scenes are identified by act, the report will be printed 
with sections for each act including subtotals for the number of 
scenes, the total number of scripted pages, and the total 
estimated running time.

This report also includes a section at the end for all of the 
questions that were entered in the ? tab of the scenes.

This report can be sorted in numerous ways but the act breaks 
are only included when the report is sorted by scene number.

Short Form Breakdown

This report is identical to the Long Form Breakdown except it 
doesn’t include the notes sections. 
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If the scenes are identified by act, this report will also be 
printed with sections for each act with subtotals.

This report can be sorted in numerous ways but the act breaks 
are only included when the report is sorted by scene number.

Short Form Export

This function will export the short from breakdown into a format 
that can be loaded into an Excel spreadsheet.

Daily Partial Progress Report

This report is a subset of the full Daily Progress Report 
described below that can be used as a lunch or midday progress 
report.

Daily Progress Report

This report is a one page summary of the day’s activity 
including to date totals for the progress of the production and 
projected running times for the finished production based on 
current progress.

Include Partially Credited Scenes in Totals

By default the Daily Progress Report only includes the eighths 
from fully credited scenes in the totals. If you would like to 
include the eighths from partially credited scenes, click this 
menu item so that a check-mark appears next to it. 

Daily Editor Log

This report is a listing of all slates and takes for use by the 
editor. It can be sorted by the order shot or by camera roll.

Daily Editor Log Red Camera

This report is similar to the Daily Editor Log but includes the 
Clip # field.

Daily Timecode Log

This report is a listing of all slates and takes with timecode 
in and timecode out for each take. It can be sorted by the order 
shot or by camera roll.

Daily Timecode Log w/Photos
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This report is a listing of all slates and takes with timecode 
in and timecode out for each take as well as the representative 
photos for each take. It can be sorted by the order shot or by 
camera roll.

Circle Takes Only

This option appears below the Daily Editor Log, Daily Editor Log 
Red Camera, Daily Timecode Log, and Daily Timecode Log w/Photos 
reports. Check this option to include only Circle takes in the 
respective report.

Daily Face and Lined Pages

This report includes the facing pages for all shots for the day 
and all affected script pages sorted in order. Facing pages for 
shots from other shoot days are not reprinted but any script 
page with a scene that was included in a shot today is included.

Include Representative Photos

If you want to include representative photos in the body of the 
facing pages in the Facing and Lined Pages report, click this 
menu so that a check-mark appears next to it.

Daily Coverage

This report prints a kind of proof sheet of representative 
photos for all circle takes for today’s slates/takes.

Daily Clip Bin File

This process creates a tab delimited file with all slates and 
takes for the day that can be imported by a transfer house or 
editor.

Camera Rolls

This report prints a list of all camera rolls used so far in the 
production with a list of all slates and takes shot on each 
roll.

Sound Rolls

This report prints a list of all sound rolls and the slates and 
takes, including wild tracks, that were recorded on each roll.
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Wild Tracks

This report includes a list of all wild tracks recorded for the 
production.

Scenes Owed

This report includes a list of all scenes that are flagged with 
Owe Inserts. It can be sorted numerous ways.

Wish List

This report includes a list of all wish list scenes, scenes that 
have not yet been assigned a scene number. This report can also 
be sorted in numerous ways.

Full Script and Facing Pages

This report prints all facing pages and lined script pages for 
the entire production.

Full Editor’s Log by Scene

This report is an Editor’s Log for the entire production sorted 
by scene.

Coverage for all Slates

This report prints all representative photos for all circle 
takes for the entire production in slate order.

Report to Editor

This is a summary report that can be generated anytime but is 
generally used at the end of the production to provide summary 
information to the editor.
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Configuration

ScriptE allows you to customize various setting such as color 
preferences and standardized pick lists to “make it your own” or 
to handle different situations that arise for particular 
productions. 

There are two ways you can set the preferences: Globally, 
Specific Production

Globally

ScriptE maintains a global set of preferences that are copied 
into a production file when you start a brand new production. 
You might call these your default settings. 

You will set these from the main ScriptE window using the 
Preferences menu.

If you make changes to the default settings, those changes won’t 
affect any existing production files. Only future production 
files. So, if you want the changes to affect an existing 
production, you’ll need to make the changes in that file.

Specific Production

After the default settings are copied into your production file, 
you can make modifications that will only apply to that 
production file. For example, if your default color setting for 
camera A is blue but the editors prefer to have the camera A 
lines be brown, you can set the A camera color to brown just for 
this production.

You will set these in your production file under the Edit menu 
then the Preferences menu. 

Having specific settings within the production file also allows 
you to send the file to someone else and the preference settings 
won’t be affected by the other person’s default settings.

Another advantage is that future productions won’t get cluttered 
up with various items that only applied to one specific 
production.

All descriptions below will assume that the menu used starts 
under the Preferences menu.
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Color Coding

To set the main color coding 
preferences, click the Color 
Coding menu. 

To change a color, click in the 
color box for the item. A Color 
Selection window will be 
displayed. Click on the desired 
color then click the OK button.

After making your selections, 
click the Save button.

ScriptE allows you to select a 
color for the following items:

1st Shot/Take Action Note

When you add action notes 
during the first take of the 
first shot for a scene, the box around the note will be 
displayed on the script using this color. These notes are 
considered the preferred action for the scene that was 
established during rehearsal or during the first take for the 
scene.

Subsequent Take Action Note

Action notes added after the first take will be displayed using 
this color. These notes are considered exceptions to the 
preferred action as recorded during the first take. The slate 
and take number will also be displayed with these notes.

Alternate Dialog

These notes are used to record alternate dialog when an actor 
says a different word or phrase than the dialog in the script.

Inserted Dialog

These notes are used to record an entirely new line of dialog by 
a character that wasn’t scripted at all. This dialog would 
normally be inserted into the middle of another character’s 
dialog but could be before or after another character’s dialog.
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Omitted Dialog

These notes are used to record a word or phrase that an actor 
omitted.

Scripted Dialog

Dialog changes can be used to alter the actual text of the 
script. If the director decides that an alternate line of dialog 
that an actor has been using should be used for all shots going 
forward, you can modify the script and insert the new dialog. 
Similarly, if an omitted line is to be omitted for all 
subsequent shots, you can remove the line from the script.

When the script is altered in this fashion, the original text of 
the script is displayed along with the dialog change notes so 
you can always see what the original dialog was.

Wild Track Lines

As shooting progresses, all the camera lines drawn for the 
previous shots of a scene are drawn on the script as well as any 
wild track lines. The colors for the camera lines are determined 
by the camera line color settings. The color selected here 
determines the color of the wild track lines.

After selecting the desired colors, close the window. You can 
change the colors at any time. ScriptE doesn’t store the color 
with each affected item. It looks up the required color when 
displaying the item so the current color scheme will always be 
used.

Breakdown Scene Heading Text

This is the color for the scene heading in the long and short 
form breakdown report. You can change the color to make the 
report easier to read.
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Show Shot Look on Camera Lines

The camera lines are normally drawn on the shot coverage window 
and the lined script based on the shot look type selected for 
the camera in a shot which you will learn about later in this 
document. The wider the shot, the further left the line will be 
displayed. The closer the shot, the further right the camera 
line will be displayed. So, the position of the line indicates 
what type of shot it is. 

But, if you prefer to show the camera lines in the order shot, 
you may want to include the shot look type description along 
with the line. To include the description, be sure the Show Shot 
Look on Camera Lines menu is checked.

Pick Lists

In order to save some typing and avoid typos, ScriptE has 
several pick lists of standard items that you will select from a 
drop-down pick list to fill in data for various fields.

You will find a menu for 
each list of items under 
the Manage Pick Lists 
menu. When you select a 
list to manage, a window 
similar to the one shown 
below will be displayed.

Managing a list is similar 
for all of the lists 
except Shot Look Types. 
S e e t h e s p e c i f i c 
i n s t r u c t i o n s i n t h e 
section for Shot Look 
Types. 

To add an item to the 
list, click in the cell in 
the row with the “*” and 
type the new value.

To delete an item from the list, click the gray row header to 
the left of the description then press the Delete key.

You can control the order in which the items will appear in the 
drop-down pick list. To change the order, select an item in the 
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list then click the Move Up button to move it higher in the list 
or click the Move Down button to move it lower in the list.

Participant Types

When you add participants to the production for the purpose of 
emailing reports to them, you will identify each participant’s 
role in the production using this list. In addition, the names 
of any producers and the name of the director will be included 
in the heading of the Daily Progress Report.

Script Int/Ext Types

This list should include all possibilities that might be found 
in a script.

Take Types

This list is used to identify the different types of takes. If a 
take is identified as a “Pick Up” take, “PU” will be appended to 
the take number when the take number is displayed or printed in 
a report.

Take Select Types

After each take, you will have the opportunity to note the value 
of the take by selecting an item in this list then adding a 
comment.

Camera Mode Types

This list is used to identify the type of camera or camera 
mounting that was used for a shot. This selection is included in 
the shot description that will go to the editor.

Camera Types

This list is used to identify the camera body that was used for 
a shot. You can also select a different color for each camera 
letter to better identify the camera lines for the coverage of a 
shot both on screen and in the Lined Script pages.

Click the Select button in the Color column and select the color 
for the camera letter.
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Film Stock Types

This list is used to identify the film stock for each camera 
roll.

Shutter Angle Types

This list is used when entering information for the camera that 
was used for a shot.

Shot Look Types

The shot look types describe 
the shot ranging from wide to 
close up. This selection for 
a camera in a shot also 
determines where the camera 
lines will be drawn on the 
script, the wider the shot, 
the further left the line 
will be drawn. The closer the 
shot, the further left the 
line will be drawn.

The script is divided into 
five zones. Each shot look 
type is assigned into one of 
the zones.

If you want to the camera lines to appear in the shot window and 
on the lined script in the order they were shot, put all Shot 
Look Types in zone 3.

Show Shot Look on Camera Lines

When the camera lines are displayed in the order shot by placing 
all Shot Look Types into zone 3, it may not be clear what type 
of shot each line represents. Checking the Show Shot Look on 
Camera Lines menu will tell ScriptE to include the description 
as entered in Shot Look Types above with the camera line.

Default Types

Since you can make changes to the lists of items that ScriptE 
uses, you will need to identify certain items for ScriptE. To 
set these default items, click the Manage Pick Lists menu then  
the Set Defaults menu.
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If you have not changed any of the pick list items, you should 
not need to make any changes here. But, if you have changed the 
pick list items, select the appropriate item for each of the 
default selections and save your selections.
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Where are My Pick Lists and Photos Stored?

When you started ScriptE for the first time, a file named 
“ScriptEPickListData.ssd” was placed into a folder that ScriptE 
created on your hard  drive called “ScriptE Data.” This is also 
the location where all of your photos are stored  as well as 
daily reports that have been emailed.

If you want to check the location, click the Help menu then the 
Where are My Pick Lists and Photos Stored? menu.

Change Location of ScriptE Data

If you need to or want to change the location where all of these 
files are stored, you should copy “ScriptEPickListData.ssd” and 
all of the files and folders that are in the same location as 
that file to the new location. Then, click on the Change 
Location of ScriptE Data menu under the Help menu. You will be 
r e m i n d e d o f t h e s e s t e p s t h e n p r o m p t e d t o s e l e c t 
“ScriptEPickListData.ssd” in the new location. ScriptE will now 
use the new location.

Deactivate ScriptE

If you purchase a new computer or need to move ScriptE to a 
different computer, you will need to deactivate ScriptE on the 
old computer before you will be able to activate it on the new 
computer. 

To deactivate ScriptE, be sure you are connected to the Internet 
then click the Help menu then the Deactivate ScriptE menu. 
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